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1 Introduction 
The purpose of this manual is to document the CO2DB software as it stands after 
reprogramming and the inclusion of additional data. Although not a tutorial, this manual is 
designed to facilitate a step-by-step approach to mastering more and more features of 
CO2DB. 

1.1 What is CO2DB? 

CO2DB was designed as a tool to collect detailed data on carbon mitigation technologies in a 
standardized format. Currently, CO2DB contains approximately 3000 technologies. CO2DB 
is an interactive software package describing in detail the technical, economic and 
environmental characteristics of technologies as well as data pertaining to their innovation, 
commercialization and diffusion. CO2DB also serves as a tool for performing comparisons 
and other basic data analysis.  

1.2 What can you do with it? 

With CO2DB one can add to, select, filter, arrange, and compare CO2DB’s data according to 
any of the technology characteristics included in each database entry. One can also make 
energy chain calculations as well as comparison tables and graphics on the technology and 
the chain level. The results can be saved as ASCII or TEX files or postscript graphics. The 

results can be exported to spreadsheets such as Excel (using the export function described in 
Section 7.1) for further data handling. 

1.3 Overview of this manual 

Section 2 describes the installation of the software under Windows 95/98/NT/2000/XP using 
the CO2DB installation compact disc. Section 3 gives an overview of basic design features of 
CO2DB. Section 4 describes the first steps of information retrieval, i.e., opening a database 
and selecting technologies for which information is to be retrieved. Section 5 describes how 
to view the data tables belonging to each set of selected technologies and how to export them 
for further processing. Section 6 describes the steps involved in modifying the existing 
database (as delivered on the CO2DB compact disc) and creating new ones. Section 7 gives 
an overview of the most important CO2DB tools for data analysis. Section 8 explains how to 
take care of units and how to insert definitions. Section 9 discusses reports, Section 10 
describes how to get user assistance, and Section 11 describes known bugs. Appendix 1 
contains more formal reference information. 

1.4 Acknowledgement 

The development of CO2DB includes input from many colleagues. For this version of 
CO2DB, we wish very much to thank Takeyoshi Kato from Nagoya University in Japan, who 
implemented and collected the additional data.  

2 Installing and Starting CO2DB 
To initiate installation of CO2DB in Windows 95/98/NT/2000/XP from the CD-ROM, insert 
the CD-ROM in a CD-ROM drive, and double-click on SetupCO2DB.exe. This starts a setup 
wizard that is self-explanatory. To initiate installation from an e-mail attachment, simply 
double-click on the attachment icon for SetupCO2DB.exe. This starts the same setup wizard. 
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The first wizard screen suggests closing all other Windows programs and gives you the 
opportunity to do so after exiting the wizard by clicking the “Cancel” button. 

The next wizard screen asks you to login by entering your name and company. 

Once you are logged in, the next wizard screen allows you to select the destination folder in 
which to install CO2DB. After doing so click the “Next” button to move to the fourth wizard 
screen. 

The fourth wizard screen allows you to choose the type of installation you prefer. There are 
three options to choose from:  

•  Typical: Program will be installed with the most common options. Recommended for 
most users. 

•  Compact: Only the program will be installed, leaving your data files untouched. 
•  Custom: You can chose the options to install. Recommended for advanced users. 

Choose one of the options and then click the “Next” button. 

Next will come a screen which will add program icons to the Program Folders. You may type 
a new folder name or select an existing one from the existing folder list. Click “Next” to 
continue.  

The next screen “Start Copying Files” asks if you want to review and check any of the 
settings you have chosen. If you are satisfied with your selections, click “Next” to proceed 
with the installation. 

The final wizard screen should report that the installation has been successfully completed. 
Click the “Finish” button to close the wizard and end the installation procedure.  

To run CO2DB, just select Start  Programs  co2db. This will execute the file 
“co2db.exe” from the folder “<installDir>/IIASA/co2db”. 

3 Basic Design of CO2DB 
CO2DB is organized as a relational database system. To date it has been used with database 
systems such as Microsoft Access, Oracle and Postgres. The current implementation uses 
Gadfly, an open-source database completely implemented in Python (see 
http://gadfly.sourceforge.net/). 

The technologies included in the database are characterized by the “technology name”, the 
economic “sector” in which they are used, the technology “type”, and their position in the 
reference energy system (RES) (see Figure 1), which is expressed as “input” from and 
“output” to a specific level in the RES. 

Within CO2DB each technology is characterized by a unique technology number issued 
internally, which the user cannot change. 
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Each technology’s data are described in six tables: one main table (called GEN) and six sub-
tables: technology data (TEC), economic data (ECO), environmental data (ENV), materials 
data (MAT), data on applications (APP), and literature references (LIT). Multiple sub-tables 
can be used to describe different versions of one and the same technology (e.g., data sets for 
different years of production, different regions, different installation sizes, etc. (see Figure 2.) 

The number of sub-tables need not be equal for different versions of the same technology. 
For example, if several versions of the technology are based on the same literature source, a 
separate literature sub-table is not needed for each version. As each of these sub-tables is 
characterized by an identification label (ID), care has been taken to choose the IDs so that 
they can be recognized easily as sub-tables belonging together (see the example in Table 1).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 1: Reference Energy System (RES). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2: Representation of a technology with multiple versions. 
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Table 1: Example: Sub-table names for a technology. 
  TEC ECO ENV MAT APP LIT 

id32_weu id32_weu 
id32_nam id32_nam 

id32_oecd 
Version 

id32_lam id32_lam id32_devs 
- - id32_all 

 

One important area in the database design is units. Seemingly strange units (such as dollars 
per annual seat kilometers for the costs of an automobile) serve the purpose of using the 
database information directly for modeling. The reason for following a rather strict scheme 
for units is CO2DB’s ability to perform chain calculations. For the software to be able to do 
this, costs must be defined in currency unit per energy (service) unit and efficiencies must be 
defined in energy unit per energy (service) unit.  

At input time, the user is advised to add units to each quantitative piece of data. If units are 
used that are included in CO2DBs “units” tables, they can always be automatically converted 
to other units, e.g., to facilitate the comparison of cost or performance data of different 
technologies. The automatic conversions are based on CO2DB-internal conversion tables for 
each type of units. The conversion tables must be maintained by the user. From the main 
screen these conversion tables can be reached via Tables  Units  unit table. See also the 
description of “conversion tables” in Appendix 1. 

4 Opening the Database and Selecting Technologies 
The database is opened by selecting the ‘File’ drop-down menu from the main screen and 
clicking on ‘Open’. A selection menu allows the user to open the desired database by double-
clicking on its name. Currently there are four possibilities. “co2db” is the comprehensive 
database likely to be used by most users. “china” and “india” are smaller databases created 
for specific projects. Most of the technologies in these databases are also in “co2db”. 
“other…” is a placeholder for future possible additions and currently does not lead to 
additional databases. 
 
After a database has been successfully opened, the other drop-down menus of the main 
screen are also made selectable. By clicking on ‘Select’ a drop-down list allows the user to 
select technologies according to the following criteria: 

Table 2: Selection criteria. 
by sector... Sector of economy (industry, transport, agriculture, etc.)  
by input level... Energy input level (primary, secondary, final, etc.)  
by input fuel...*) Fuel name (coal, oil, gas, etc.)  
by output level... Energy output level (primary, secondary, final, useful, services) 
by output fuel...*) Fuel name (gasoline, electricity, gas, district heat, etc.)  
by type... Technology type (efficiency improvement, fossil fuel conversion, etc.)  
by author... Person(s) who entered data  
by regex...**) A regular expression used to select from technology names (e.g.: .*gas.*) 
enter new tec User may input new technologies 
from all Selection of all technologies  
previous list... Reselect previous list 
*) these two selections lead first to the selection of the level on which the fuel should be searched for  
**) a UNIX-style regular expression (like in vi) which allows search strings with *, ?, ., etc. 
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After selecting a category from the above list, a list with matching technologies is shown, 
from which one can be selected by double-clicking its name. The main technology table with 
general information is shown. ‘Previous’ and ‘Next’ buttons on the main technology table 
allow one to move up and down the selected list of technologies. The buttons TEC, ECO, 
ENV, MAT, APP, and LIT allow one to view, respectively, technical data, economic data, 
environmental data, materials consumption data, data on applications of the technology, and 
the relevant literature references. 
 
The main technology table of the selected technology (denoted by the suffix “(gen)” in the 
title bar) contains the following data:  

Table 3: Data in the main technology table. 
Field name Description 
Technology name Long name of technology 
ID Identification of technology (is set automatically, but can be changed)
No Sequential number of technology (cannot be changed) 
Technical availability Year when technology became technically available 
Commercial availability Year when technology became commercially available 
By Name of person who entered the data 
Valuation Valuation of data quality  
Invention Year of invention 
Innovation Year of major innovation 
Prototype Year when first prototype became operational 
Commercial Year of commercial availability 
1% market share Year when 1 percent market share was reached 
50% market share Year when 50 percent market share was reached 
Life-cycle phase Description of current life-cycle phase 
Notes Field for notes 
Sector Sector in which this technology is used (e.g., agriculture)  
Type Type of technology (e.g., electricity production)  
Output Name of fuel output level  
Input Name of fuel input level  
File Computer file with additional information  
Hard copy Hard copy file with additional information  
 

5 Viewing and Retrieving Technology Data 
The remaining six tables (TEC, ECO, ENV, MAT, APP, and LIT) are generally divided into 
four sections: 

1 A title bar showing the technology name and the table type, 
2 A bar with pull-down menus,  
3 An area with push-buttons, and 
4 The data section. 

 
All tables show the information on technology name, identifier, number, technical and 
commercial availability, author and valuation as they also appear on the top of the main 
technology table. This information cannot be changed in the sub-tables. 

The sub-tables also all contain a field called ‘Table ID’. This field makes it possible to 
distinguish between different applications of the technology (e.g.: different degrees of 
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desulphurization, specific installations, applications in different years, etc.). The adjoining 
push-button ‘ID list’ creates a window showing the currently used IDs for this technology.1 
To change the ID of the current technology, enter the new ID and press the push-button 
‘change ID’. (See also the description of CO2DB’s basic design in Section 3.) 

Where appropriate the tables contain radio buttons, which indicate if the data are given per 
unit of main input or output.  

Only the “Table ID” and the “Data per” radio buttons can be changed. 

Table 4: Common data fields at the top of all sub-tables. 
Field name Description 
Technology name Long name of technology 
ID Identification of technology  
No Sequential number of technology  
Technical availability Year when technology became technically available 
Commercial availability Year when technology became commercially available 
By Name of person who entered the data 
Valuation Valuation of data quality 
 
In cases where there are different tables belonging to the same technology, the buttons 
‘Previous’ and ‘Next’ in the button area can be used to switch among them.  

5.1 The technical data table (TEC) 

The technical data table, denoted by the suffix “(tec)” in the title bar, for each technology 
includes the information listed below in addition to the seven items that are common to all 
tables. 

Table 5: Data items in the technical data table. 
Field name Description 
Unit size Size of a single unit (e.g., powerplant with 100 MW) 
Technical availability Maximum availability factor 
Average utilization Average availability factor 
Construction time Time needed for construction of the plant 
Plant life Length of useful lifetime 
Inputs Energy inputs: name, amount, unit (first entry is ‘main input’) 
Outputs Energy outputs: name, amount, unit (first entry is ‘main output’) 
Notes Table-specific notes 
 
By clicking the right mouse button on the name of an input or output a selection window 
allows one to delete the selected line, add a new entry, or select an energy form name from 
the list of already used names. 

                                                 
1 This window is for information purposes only. Different technologies have been entered into CO2DB by 
different people, sometimes using slightly different conventions concerning technology IDs. The window 
summarizes the IDs used for a given technology, but does not provide a shortcut for switching among sub-
tables. 
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5.2 The economic data table (ECO) 

This table, denoted by the suffix “(eco)” in the title bar, contains economic data for the 
selected technology. In addition to the seven items that are common to all tables, the 
economic data table includes: 

Table 6: Data items in the economic data table. 
Field name Description 
Currency/year Currency in which the following data are given 
Investment costs Investment costs per unit (amount, unit) 
Fix O&M costs Fixed operation and maintenance costs (amount, unit) 
Variable O&M costs Variable operation and maintenance costs (amount, unit) 
Fuel costs Input fuel costs (amount, unit) 
Decomissioning costs Costs for decomissioning the plant (amount, unit) 
Total (excl. fuel) Total production cost excluding fuel costs (amount, unit) 
Total (incl. fuel) Total production cost including fuel costs (amount, unit) 
Notes Table-specific notes 
 
Note that not all the entries in ECO tables are independent. Where both total costs and 
component costs are entered, the components should sum to the totals. If a user inputs new 
data, it is the user’s responsibility to check for consistency. The software will not alert the 
user to inconsistencies. Nor will it do the calculations automatically. 

5.3 The emissions data table (ENV) 

This table, denoted by the suffix “(env)” in the title bar, contains data concerning emissions 
from the selected technology. In addition to the seven items that are common to all tables, the 
environmental data table includes:  

Table 7: Data in the emissions data table. 
Field name Description 
Pollutants (e.g., CO2, NOx, SOx) Name, amount, unit 
Notes Table-specific notes 
 
By clicking the right mouse button on the name of a pollutant a selection window allows one 
to delete the selected line, add a new entry, or select a pollutant name from the list of already 
used pollutant names. 

5.4 The material consumption data table (MAT) 

This table, denoted by the suffix “(mat)” in the title bar, contains data on materials 
consumption and labor requirements during construction and operation of the selected 
technology. In addition to the seven items that are common to all tables, this table includes: 

Table 8: Data in the materials data table. 
Field name Description 
Labor Amount, unit 
Materials  Name, amount, unit 
Notes Table-specific notes 
 
By clicking the right mouse button on a name on the materials list, a selection window allows 
one to delete the selected line or to add a new entry. 
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5.5 The application data table (APP) 

This table, denoted by the suffix “(app)” in the title bar, contains additional information on 
current installations, producers and known limits as listed below: 

Table 9: Data in the application data table. 
Field name Description 
Region World region in which the described unit is installed 
Producer Producer of the described unit 
Research Research laboratory working on R&D of the technology 
Prerequisites Prerequisites for installing a unit 
Limits e.g., maximum unit size, maximum total installations (description, value) 
Existing installations Number/size of existing installations (description, value, unit) 
Notes Table-specific notes 
 
By clicking the right mouse button on the name field of the limits list, a selection window 
allows one to delete the selected line or to add a new entry. 

5.6 The literature data table (LIT) 

This table, denoted by the suffix “(lit)” in the title bar, contains information on where the data 
given in the other tables were found. 

Table 10: Data in the literature data table. 
Field name Description 
Book title Book/article/paper in which the information was found 
Chap. Title Chapter title  
Author Author(s) of the cited reference 
Publisher Publisher of the cited reference 
Type Type of reference (book, article, paper, etc.) 
Year Year of publication 
IIASA-Nr. IIASA publication number 
Access Where to get the book/article 
Notes Table-specific notes 
 

6 Modifying the Database 
Most data entered are only stored in the database when the user clicks ‘save’ in the ‘Table’ 
drop-down menu or after clicking ‘Save’ in the dialog box which appears if the user wants to 
leave a table without having saved it before. Exceptions are data entered into multiple entry 
blocks (inputs, outputs, pollutants, etc). These data are saved immediately. If a wrong item 
was entered in such a block, that item has to be deleted by hand (select wrong line  click 
right mouse button  select delete) as currently no undo option exists. 
 
There is no set of required data that have to be entered, and the software does not prevent the 
user from saving the table if not all data were entered. Only tables in which no data were 
entered are not saved. 

6.1 Creating a new database 

To create a new database click on File->New. An entry-window will allow the user to enter 
the new database name and a short description of this database. If this database should be 
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started as a copy of an existing database, fill also the field ‘Copy of:’ with the name of the 
base database. This database will be copied to the new database. This database can then be 
used like any other database in the system. If the new database already exists a selection 
dialog allows to overwrite the existing database or to stop the action. 

6.2 Entering new and modifying existing technology data 

To enter a new technology, select the ‘Table’ drop-down menu from the technology main 
table for any technology and select “New”. This opens a new table with a new technology 
identifier and a sequence number. All other fields are empty or contain default values. You 
will note that when the pointer on the screen rolls over some of the fields for entering data, it 
changes to a finger pointing to the right. When it does, clicking on the right mouse button 
will open a window showing all the entries used elsewhere in the database for that field. 
Double-clicking on one of the options in the window will insert it in the appropriate field. 
 
When clicking on one of the buttons to open a sub-table of a new technology, a small window 
appears, indicating that no such data are available. Click on the button ‘New data’ to open a 
new, empty sub-table. 
 
For adding additional sub-tables (e.g., for different versions of a technology in terms of 
installation sizes, years, etc.), select Table  New in one of the existing tables.  
 
To modify data, just enter new values in the required fields. 

6.3 Deleting and copying selected technologies 

To delete a complete technology, select the ‘Table’ drop-down menu from the technology’s 
main table (GEN) and click on delete. To delete one of the sub-tables, select the according 
button in the sub-table. 
 
Copying technologies inside the same database or between databases can be accomplished by 
exporting (using the pull down menu ‘Export’ in one of the data tables) and importing (using 
the pull down menu ‘File’ from the main window). The import function ensures that 
technology names, identifiers and numbers remain unique. If there is a conflict, a pop-up 
window will appear giving the user an opportunity to modify a name, identifier, or number to 
eliminate the conflict. 

7 Processing Data 

7.1 Technology comparisons 

Technology comparisons are started from the pull-down menu ‘Comparison’ in the main 
menu. The selection of ‘Select’ opens the same list of technology categories as the Select 
option on the main window. Once a category is selected, a window appears listing, in its top 
section, the features of technologies that the user might want to compare and, in its bottom 
sections, the technologies in the category chosen. These all appear in the left section of the 
window. By clicking on entries in the left-hand lists they are selected and inserted in the 
right-hand lists, indicating that these are the features and technologies the user wishes to use 
in the comparison. If there are several versions of a technology, windows will appear asking 
the user which should be used in the comparison. To deselect items click on them in the right-
hand lists to insert them back into the left-hand lists. A selection list can be saved into a file 
by clicking the push-button ‘Save’. Such saved files can later be used by selecting ‘Existing’ 
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from the drop-down menu ‘Comparison’ in the main window. In this case, the data are 
extracted from the database at the time at which the results are viewed. 
 
Once the features and technologies that the user wants to compare have been selected and 
appear in the right-hand lists, the results of comparisons can be viewed as tables (using the 
push-button ‘Table’), aligned bars (‘al. Bar’), or stacked bars (‘st. Bar’).  
 
The item ‘New’ on the drop-down menu ‘Comparison’ in the main window allows the user to 
choose a new combination of features and technologies to compare using the same 
technology category as in the last comparison. 
 
Comparison results can be saved as an ASCII table, TEX -file, or as a txt-file, which can be 

imported into a spreadsheet program such as Excel. When importing a txt file into Excel the 
import wizard might ask for information about the file (delimited or fixed width). Choosing 
“delimited” and then “tab” guarantees that data appear neatly in columns. 

7.2 Chain calculations 

Chain calculations are used to calculate the overall costs or emissions of concatenated 
technologies, e.g. the chain: Refrigerator  electricity transmission  coal power plant  
coal transport  coal extraction. 

Chain calculations are started from the drop-down menu ‘Chains’ in the main window. A 
chain is always constructed in the reverse order of its physical sequence, that is, it is 
constructed by beginning from any technology delivering the required energy form or energy 
service and then adding links in the direction toward primary energy up to a level chosen by 
the user. The particular technologies to be included in the chain are determined by the user 
constructing the chain. The item ‘New’ allows one to start constructing a new energy chain in 
the following way. 

First a window with a list of the available energy levels is shown. The selection of a level 
leads to a window showing the energy forms on that level, and the selection of an energy 
form leads to a window showing all technologies producing the selected energy form on the 
selected level. By selecting a technology another window pops up, which shows all 
technologies producing the input fuel for the technology selected before. This sequence can 
be repeated until the end of the chain in the direction of primary energy is reached. The 
window for selecting the next technology always contains three push-buttons: ‘Calculate’ to 
stop further selections and to start the calculation, ‘Show list’ to show which technologies 
have been selected so far, and ‘Quit’ to stop the selection process. 

If a technology requires an additional energy input (“by-input”), the user is requested to state 
the cost of this additional input into the energy chain. The questioning about these costs can 
be controlled via radio buttons in the menu reached via Tables  user units from the main 
window (see Section 8.1). 

 
 
 
 
 
Figure 3: Representation of a chain with an additional input (“by-input”). 
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After the chain calculation is performed, a new window shows the results and allows the user 
to save the selected chain, or the results of the calculation. In order to compare different 
energy chains, each selected chain must be saved via the ‘Save chain’ button. 

7.3 Chain comparisons 

Chains that have previously been saved to files can be compared to each other by clicking on 
‘compare’ in the Chains drop-down menu in the main window. This selection shows a file 
selection window from which the required files can be selected. After selecting a chain file 
the file selection reappears allowing the selection of another chain file for comparison. To 
end the selection process, click on ‘Cancel' in the file selection menu. Then a window like the 
one used for technology comparisons pops up and allows the user to select the items to be 
compared. Again, like with technology comparisons, the result may be saved as simple 
tables, TEX files, txt files with tab-separated entries, or as postscript files. 

8 Units and Definitions Tables 
The rightmost drop-down menu on the main screen is ‘Tables’. It allows the user to set his or 
her preferred units for technology and chain calculations and comparisons, to define 
conversion factors between different units, and to enter descriptions for various lists used in 
the data tables. 
 
Additionally this drop-down menu also contains the entries ‘Database’ and ‘Cleanup’. The 
first entry allows one to view the data tables or export them in CSV-format. The second entry 
tries to synchronize all the tables containing fuel and level entries, which may become 
inconsistence after deletions of technologies or inputs to /outputs from technologies. (Such 
inconsistencies may be detected when the selection of certain elements show matches in one 
selection but not in another. 

8.1 Output units  

The units defined in this table are those to be used in the tabular and graphical outputs from 
the calculations possible within CO2DB. The four radio buttons towards the end of the table 
let the user define which action to take if, during the calculation of an energy chain, a 
technology has “by-inputs” (see Section 7.2). In order to calculate the total cost of the chain a 
value for this by-input should be supplied, but the user can also decide to skip the entry of 
such additional costs. This is the same as entering costs of zero. 

8.2 Units 

The unit tables offered under this label allow the user to enter the conversion factors for all 
units used in the data tables. There is always one unit designated by the word MAIN. All 
other conversion factors must reflect the multiplicative value to convert from the given unit to 
the one designated MAIN. 

8.3 Definitions 

These tables allow the user to add descriptions to the items in the various lists used in the data 
tables (sectors, levels, fuels, etc.). These definitions are solely for documentation. A click on 
the right mouse button in the left column allows the user to add or delete categories. One 
should be careful not to delete categories that are still in use. 
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Before showing the table with definitions, the user is asked if the table should be updated 
from the database. If this is answered with ‘Yes’, all elements currently unused are deleted 
and new values are inserted into the definitions table.  

8.4 Database 

This option allows one to select one of the data sheets contained in the database for viewing 
on screen or exporting it in csv format for import into other tools. 
 
Note: When viewing data tables it may take a rather long time to set up the screen. A warning 
is issued when a certain table size is exceeded, but, of course, the time required to set up the 
screen depends on the computer speed. The export of tables and import into Excel, etc. is 
often much faster for large tables (mainly the gen-table). 

8.5 Clean up 

After clicking this selection, one can see on the underlying text window how many entries 
were deleted or inserted into the different tables. 
 
Note: The synchronization of tables is not very well tested, but, on the other hand, showed no 
problem so far. 

9 Reports 
Reports, in the forms of the tables and graphs that can be created from CO2DB as described 
in Sections 7.1 and 7.3, cannot be printed directly using CO2DB. To get printed reports, the 
user must first save results as ASCII, TEX, or txt files if they are tables, and as postscript 

files if they are graphics, as described in Sections 7.1 and 7.3. The saved files must then be 
imported into another application, such as an Excel spreadsheet, from which the desired 
reports can be printed. 

10 User Assistance 
A limited user service in cases of unforeseen troubles with CO2DB is available via e-mail. 
For general software features and installation, please contact Manfred Strubegger (strub@iiasa.ac.at).  

11 Known Bugs 

11.1 Technology comparison 

When doing technology comparisons, a selected technology disappears from the left-hand 
lists after one combination of sub-tables has been selected. It should remain in the window 
until all possible combinations are selected. 
 
The only possible way to work-around this is to not use the feature of sub-tables. 

11.2 Technology tables 

The valuation field in the main technology table should have a selection window with pre-
defined criteria. 
 
Data entered in multiple-entry blocks in technology sub-tables are stored immediately to the 
database. 
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11.3 Multiple entries 

After clicking the right mouse button in the multiple entry sections of the MAT and APP 
screens (Materials, Limits, Existing installations) the focus cannot be set to any other field. 
 
Click the right mouse button again in any of the multiple entry sections, then into any other 
field to overcome this blocking. 
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Appendix 1: Organization of CO2DB 
The relational database in the background of CO2DB consists of the following tables: 

Data tables: 
Gen*) general data 
Tec*) technical data 
Inp input fuels 
Out output fuels 
Levfuel energy forms/levels cross table 
Eco*) economic data 
Env*) environmental data 
Pol Emissions 
Mat*) materials data 
Cmat construction materials 
Omat operation materials 
App*) data on actual installations 
Lim Limits 
Lit*) literature data 
Supporting tables: 
Sectab sectors (descriptions) 
Typtab technology types (descriptions) 
Levtab energy levels (descriptions) 
Polltab pollutants (descriptions) 
Fueltab energy forms (descriptions) 
Colortab color table for pollutants 
Conversion tables: 
Enetab energy units conversions 
Montab monetary units conversions 
Multab Multipliers 
Powtab power unit conversions 
Timtab time unit conversions 
Wgttab weight unit conversions 
User’s table: 
Users user’s default values 

 

The data tables are accessible via the CO2DB interface. Tables marked with an asterisk (*) 
are the main tables, which also are represented as separate windows on the user’s interface. 
Each technology (defined in gen) can have more sub-tables (tec, eco, ...) to describe variants 
of the basic technology. 

The supporting tables are basically controlled by CO2DB, but the user can add descriptions 
to the items contained in these tables via Tables  Definitions from the main screen.  

The conversion tables must be kept up to date by the user. The latter tables are needed to 
convert data, which are often supplied in different units, to a common unit. If new units are 
used, CO2DB complains about missing conversion factors, and the user must then update the 
according tables via Tables  Units from the main screen. Each of these tables must contain 
one unit which is marked with the word ‘MAIN’, all other conversion factors must be given 
relative to this unit. 

The User’s table contains the user’s preferred units, which he or she would like to see used 
when results are presented. The user is identified by the environmental variable USER. This 
table can be reached via Tables  Output Units from the main screen. 
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